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Getting Started - for Windows user (Setting up your Robot)

Get the drivers and download the software to make your robots go!
. Programmer Driver

. Arduino Software IDE

o Ringo & Wink Software Libraries

Driver Installation

To prepare your computer to write code for your Wink and Ringo robots, you will need to perform the
following steps.Install the Driver for the Programming Adapter

Install the Arduino Development IDE (this is the program you'll use to write your code)

Install the Ringo Library Files

Inside Arduino, select "Arduino Fio" as the board, and select the correct port in Tools>Port

Need more help?
This is a smooth process for most people, and once you have the drivers and software loaded up on
your computer, it's easy sailing as you begin to play with your robots. If you do encounter any difficulty

getting the programming process started, please Contact Us for assistance.

Driver Installation- IMPORTANT!

Before you can use the Programming Adapter to load code onto your robots, the FTDI drivers must be
installed first. Please follow the instructions on this page to download and install the correct driver for
your computer and operating system.

It is important that the FTDI drivers be installed on your computer BEFORE connecting the programmer
to your computer.


mailto:enquiries@jswerks.com

ul Windows Driver Installation

ol
1.Download the Windows FTDI driver.
2.Run the installer as
administrator. (Right click the installer
.exe you downloaded and select "Run
as administrator" from the drop
down. It should be listed toward the
top). If not run as administrator, the
installation will likely fail.
3.0nce installation is complete, the
programming adapter may be plugged
in. Your computer should now
recognize it as a virtual com port and
assign it a com port number.

FTDI Drivers - Windows

v

-/ Mac Driver Installation

Download the Mac FTDI driver (Mac OS
10.9 and above).

Follow the Mac driver installation guide
for your version of Mac OS. You can
download the installation guide : (PDF)
If you have an earlier version of Mac OS
(10.3 to 10.8), you can download the
earlier version driver : (Download)

FTDI Drivers - Mac



http://www.ftdichip.com/Support/Documents/AppNotes/AN_134_FTDI_Drivers_Installation_Guide_for_MAC_OSX.pdf
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_2_18.dmg
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg

-

For Windows user:

® CDM21216 Setup.exe

Once the file has been downloaded, you should be able to see the
“CDM21216_Setup.exe” on the lower left of the download bar or it can be found in
the “Downloads” folder.

4 1M This PC
* | g Desktop
‘| Documents

4. Downloads —> #® CDM21216_Setup.exe

® CDM21216 Setup.exe

—

Go ahead to click on the “CDM21216_Setup.exe”

FTDI CDM Drivers

FTDI CDM Drivers

Click 'Extract’ to unpack version 2,12, 16 of FTDI's Windows
driver package and launch the installer.

wwnw ftdichip.com

Click Extract



Device Driver Installation Wizard

Welcome to the Device Driver
Q\ Installation Wizard!

~§

This wizard helps you install the software drivers that some
computers devices need in onder to work,

To continue, click Meadt.

Back E > Cancel

Click Next

Device Driver Installation Wizard

=5 To continue, accept the following license agreement. To read the entire
‘ﬁ agreement, use the scroll bar ar press the Page Dawn key.

IMPORTANT NOTICE: PLEASE READ CAREFULLY BEFORE A
INSTALLING THE RELEVANT SOFTWARE:

This licence agreement (Licence)is a legal agreement between you
(Licensee or you) and Future Technology Devices Intemational Limited

of 2 Seaward Flace, Centurion Business Park, Glasgow G41 1HH,
Scotland (UK Company Mumber S5C136640) (Licensor or we) for use of
driver software provided by the Licensor(Saftware).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE w

"Wl accept this agreement Save As Prirt
O accept this agreement

< Back et Cancel

Select “ | accept this agreement”



Device Driver Installation Wizard

License Agreement

e To continue, accept the following license agreement. To read the entire
"‘% agreement, use the scroll bar or press the Page Down key.

IMPORTANT MOTICE: PLEASE READ CAREFULLY BEFORE ”
INSTALLING THE RELEVANT SOFTWARE:

This licence agreement (Licence)is a legal agreement between you
(Licensee or you) and Future Technology Devices Intemational Limited

aof 2 Seaward Place, Centurion Business Park, Glasgow G41 THH,
Scotland (UK Company Mumber SC136640) (Licensor ar we) for use of
driver software provided by the Licensor(Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE w

(®) | accept this agreement Save As Pririt

()1 dont accept this agreement

< Back N? > Cancel

Click Next

Device Driver Installation Wizard

Completing the Device Driver
Q\ Installation Wizard

3

The drivers were successfulty installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

»# FTDI COM Driver Packa... Ready to use
w* FTDI COM Driver Packa... Readyto use

Back Finish Cancel

Installation of the Driver Completed



ARDUTHO Arduino IDE Installation

Arduino is the program you will use to actually write code for your robots. It is kind of like a text editor or
word processor for computer code. Arduino includes its own compiler that runs in the background, so no
additional tools are required.

Download Arduino for your Operating System

Windows installer
Windows ziP file for non admin install

ARDUINO 1.6.9

The open-source Arduino Software (IDE) makes it easy to Mac OS X 10.7 Lion or newer
write code and upload it to the board. It runs on
Windows, Mac OS5 X, and Linux. The environment is

% written in Java and based on Processing and other open- Linux 32 bits
source software. Linux 64 bics
This software can be used with any Arduino board. Linux ARM (experimental)
Refer to the Getting Started page for Installation
instructions. Release Notes
Source Code

Checksums.

You will want to use Arduino version 1.6.5 or later.

Visit the Arduino Software Download page and grab the correct version for your operating system.

Software

Arduino IDE

O

Once you are at the Arduino Home page, go ahead to click “Windows Installer”

Download the Arduino Software

Windows installer
Window | ;@ file for non admin install

The open-source Arduine Software (IDE) makes it easy to Mac OS )™, . or newer
write code and upload it to the board. It runs an
Windows, Mac O5 ¥, and Linux. The environment is

written in Java and based on Processing and other open- Linux 32 bits

source software. Linux &4 bits

This software can be used with any Arduino board. Linux ARM (experimental)
Refer to the Getting Started page for Installation

instructions. Release Notes
Source Code
Checksums

CONNECT, COLLABORATE, CREATE. Learn more about the Create platform. Lo EmE L =nET

Arduino Web Editor



https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software

™t Wiale
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It will lead you to this page. If you would like to make a donation to support the
Arduino Software, go ahead and click “Contribute and Download”. Otherwise, click

“Just Download”.

Support the Arduino Software

Consider supporting the Arduino Software by contributing to its development. (US tax payers, please note this contribution
is not tax deductible). Learn more on how your contribution will be used.

SINCE MARCH 2015, THE ARDUINO IDE HAS BEEN DOWNLOADED
TIMES. IMPRESSIVE! THIS IDE IS NO LONGER JUST FOR
ARDUINO AND GENUINO BOARDS. HUNDREDS OF COMPANIES AROUND THE
WORLD ARE USING IT TO PROGRAM THEIR DEVICES, INCLUDING
COMPATIBLES, CLONES, AND EVEN COUNTERFEIT. YOU CAN HELP
ACCELERATE THE DEVELOPMENT OF THE ARDUINO IDE BY CONTRIBUTING

TOWARDS THE EFFORT OF MAKING IT BETTER.

$3 $5 $10 $25 $50 OTHER

JUST DOWNLOAD CONTRIBUTE & DOWNLOAD

Click Here

Once the file has been downloaded, you should be able to see the “ardunio-1.6.9-
windo.....exe” on the lower left of the download bar, or it can be found in the

“Downloads” folder.
4 M| This PC

@ arduino-1.6.9-windo....exs » i Desktop

» | Documents

_— @ arduino-1.6.%-wind ows, exe

I g Downloads

@ arduinogl.6.9-windao....exe

Go ahead to click on the “ardunio-1.6.9-windo.....exe”
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On the Arduino Setup: License Agreement window, click “I Agree”

Arduino Setup: License Agreement - =

Please review the license agreement before installing Arduino. If vou
2.0 accept all terms of the agreement, did: I Agree.

l,.:"NU LESSER GEMERAL PLUBLIC LICEMSE ~
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.orgl=

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

This version of the GMU Lesser General Public License incorporates the terms

and conditions of version 3 of the GMNU General Public License, supplemented

by the additional permissions listed below. v

Cancel | Mullsaft Install System w2, 46

\R

Click Here

Proceed to click the “Next” button

Arduino Setup: Installation Options - =

Chedk the companents you want to install and unchedk the companents
2.0 you don't want to install, Click Mext to continue.

Select components to install: Install Arduino software
Install USE driver
Create Start Menu shortout
Create Desktop shortout
Assodate .ino files

Space required: 397.3MB

Cancel | Mullsaft Tnskall System w2, 46 < Back | Mext = I

R

Click Next




[ Duino Kids

From the Arduino Setup: Installation Folder window, proceed to click “Install”

Arduino Setup: Installation Folder > =

Setup will install Arduing in the following folder. To install in a different
o folder, dick Browse and select another folder. Click Install to start the
installation.

Browse. .. |

"Destinatiun Faolder

Space required: 397.3MB
Space available: 91.3GB

Cancel | Fullsoft Install System w2, 46 < Back | I”EE" I
\ R

Click Install

Wait for the process to complete.

Arduino Setup: Installing = =

Extract: crtm1281.0

@/ I

Zancel | Mullsaft Imstall Syskem w2, 46 = Back. Close




Next, go ahead to click “Install” the Arduino USB Driver

Windows Security

Would you like to install this device software?

Mame: Arduino USE Driver
= Publisher: Arduino srl

Always trust software from "Arduino srl", Install Don't Install

! You should only install driver software from publishers trust. How can |

decide which device software is safe to install?

The Arduino Setup is Completed
-—

o) Arduino Setup: Completed =

¢ Completed
(oo JE

Click Install

Close




-

Now you have the Arduino IDE software installed in your computer. Go to your desk
top and double click on the Arduino shortcut icon to launch the Arduino IDE
software.

Double click
to launch

Once launched, it should look like this.

€ sketch_may31a | Arduino 1.6.9
File Edit Sketch Tools Help

sketch_may3ta

P:id setup() | ~
// put your setup code here, toc run once:

1

volid loop() {
// put your main code here, to run repeatedly: ]

Arduina/Genuineg Uno on COM1

11



Locate the” Arduino folder” inside “Documents folder”

4 | Documents

* Ar@nn

Click and open this folder

| Documents
. Arduino
, libraries

And you will see a libraries folder

Next steps is to install the Ringo folder library. Go ahead to quit the Arduino software

(6] sketch_may31a | Arduino 1.6.9 = =
File Edit Sketch Toecls Help

Click to close

sketch_may31a
}.':i:i setup() { ~ Ardunlo

// put your setup code here, to run once:

}

void loop{) {
// put your main code here, to run repeatedly: !

Arduino/Genuing Uno on COM1
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Install Ringo Software Libraries

The software libraries include code you'll add to your Arduino installation. This only needs to be done one

time. Arduino will use these library files as necessary automatically after they are installed.

1) Download a zip archive including all the Ringo library files (also use these same files for Wink) Click on the
icon below:

Libraries

Ringo Libraries

2) Copy the three folders included in this zip file into your Arduino/libraries folder:

For the examples to compile, these three important folders must be copied into your libraries
folder: Adafruit_NeoPixel, RingoMsTimer2, and RingoWire

You'll need to re-start the Arduino software for it to see the new libraries.

The "libraries" folder is located inside the folder where your computer saves Arduino sketches.

== Windows Library Location: wv Mac Library Location:
My Documents\Arduino\libraries Documents/Arduino/libraries
After copying the paths should look like this: After copying the paths should look like this:
My Documents\Arduino\libraries\Adafruit_NeoPixel Documents/Arduino/libraries/Adafruit_NeoPixel
My Documents\Arduino\libraries\RingoMsTimer2 Documents/Arduino/libraries/RingoMsTimer2
My Documents\Arduino\libraries\RingoWire Documents/Arduino/libraries/RingoWire

Arduino libraries installation

For more information or help regarding library installation, check out the "Libraries" page on the official

Arduino site:
https://www.arduino.cc/en/Guide/Libraries

13


https://github.com/plumgeek/PlumGeek-Ringo-Robot/raw/master/ringo_libraries/RingoLibraries_Rev01-01.zip
https://www.arduino.cc/en/Guide/Libraries
https://github.com/plumgeek/PlumGeek-Ringo-Robot/raw/master/ringo_libraries/RingoLibraries_Rev01-01.zip

-

Once the file has been downloaded, you should be able to see the
“RingoLibraries_Rev01.....zip"” on the lower left of the download bar or it can be
found in the “Downloads” folder.

) Ringolibraries Rev0l...zip = ‘l HIHQDLIE%ES_HEYD-I'D-IIIP

V)

Go ahead to click on the “RingolLibraries_Rev01.....zip

»

Once you've unzipped the folder, you will see the following three folders:

1, Ringolibraries_RevD1-01.zip
 Adafruit_MNeoPiel
. RingoMsTimerd
. RingoWire

14



Drag and right click to copy the three folders.

Home Share View Extract

L _i » ThisPC » Downloads » Ringolibraries_Rev01-01.zip

CSL_Power_Coupler_Wall_Rev1.zip 2 MName

v @
v & Search Ringolibraries_Rev01-.. @

Type Compressed sizi

CTA_Training DVD.zip Adafruit_ NeoPixel

File folder

IntelChipsetDriver (1).zip Ri MeTi 5
. RingoMsTimer.

File folder

IntelChipsetDriver.zip RingoWi
. RingoWire

IntelGraphicsDriver.zip

IntelMEDriver.zip
JBJ_BOS.zip

nerf2photos.zip
NOA-IIT_OB5C20130523000701JWS (1) .zip
NOA-IIT_OB5C20130523000701)WS.zip
MNOA-IIT_OB0120140515085510PLX (1) .zip
NOA-IIT_OBD120140515085510PLX zip
NOA-IIT_OB57201306260357564M3 (1).zip
NOA-IIT_OB57201306260357564M3 (2) zip
NOA-IIT_OB57201306260357564M3 (3).zip
NOA-IIT_OB57201306260357564M3 zip
J PointingDriverAlps.zip
J Ringolibraries_Rev01-01.zip

. Adafruit_MNeoPixel

. RingoMsTimer2

. RingoWire
J SettingUtilitySeries.zip

EEEEEEEEEEEEEEEEEE

EE

1 SonvSharedLibrarv.zio
Jitems 3 items selected

Copy

Open
Explore

Cut

Delete

Properties

complete installation process.

Home Share View

@ - 1 . ¢ ThisPC » Documents » Arduino » libraries
W Favourites 2 Name
B Desktop | readme.txt
4 Downloads . RingoMsTimer2
%% Dropbox . RingoWire
15| Recent places J Adafruit_NeoPixel

[ ScanSnap Folder

B Desktop
& Homegroup
A limmy
1M This PC
i Desktop
| Documents
. Arduino
. libraries
. Adafruit_MNeoPixel
. RingoMsTimer2
. RingoWire
J Audacity
. Black&Decker
, CardMinder
J Certificates Template

4 items

Paste them inside the Arduino libraries folder and you are done with the

v & Search libraries 2
Date modified Type
31/5/2016 &:12 PM Text Document

/2016 7:24 PM File folder

/2016 7:24 PM File folder

/2016 7:24 PM File folder

15




|;| Duino Kids

Programming your Robot

Follow the steps and get yourself familiar with how to load the program sketch into your robot.

Windows Mac

Windows user Mac user

16
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[ Duino Kid

Once the button is clicked, it will lead you to the following page

Wink Demo

There is four fun demo software for you to get your robot up and running. These are called Arduino code files
(sketches). You may use the “Base Sketch” as a template to begin writing your code. If you are already familiar with
writing some basics, go ahead to explore your creativity or modify the other code examples to learn and have a better
understanding.

Base Sketch Use the Base Sketch to begin writing your own code.
The project automatically includes the supporting tabs
that include Wink's background functions. @

Pre-Loaded Demo This is the code that was loaded on your Wink when it was
shipped. The basic behaviours include the Wink Dance,
Barrier and Object Avoidance, and Light Seeking. You can
index between the three behaviours by pressing the BTN
button on the robot.

Drive with IR Remote This demo allows you to drive an IR equipped Wink with the
optional remote control. Use this sketch as a basis for making
your own remote control triggered behaviours.

ZOMBIE Wink! This is a fun behaviour we created for Arduino Day 2016. Load

this on two or more Wink robots and watch the Zombie
Apocalypse happen!

Click this icon to download the
“Pre-Loaded Demo*

17


http://files.plumgeek.com/software/wink/Wink_PreLoadedDemo.zip

-

Once the file has been downloaded, you should be able to see the
“Wink_PreLoadedDemo.zip” on the lower left of the download bar or it can be found
in the “Downloads” folder.

I Win k_PreLoadedDemo.zip

N

Click to open the zip file

4 M| This PC
* pg Desktop ;
2l Documents Mame Type
b & Downloads —> || Wink_PreLoadedDemo_RevD1 File folder

R

Or double click to open the zip
file from the downloads folder

Once the compressed folder is opened, you should be able to see all the
Wink_PreLoadedDemo folder.

1 | E:i’ = | Compressed Folder Tools
Home Share Wiew Extract
”(_) * T 1) » ThisPC » Downloads » Wink_PreLoadedDemo (1).zip
~ -

. Favourites Mame Type

B Desktop ; Wink_PreloadedDemo_Revl File folder
4 Downloads

%7 Dropbox

| Recent places

5 ScanSnap Folder

B Desktop



Create a new folder in the Arduino folder and rename it as “demo

software”

bl L =

© = -t

i Favourites
B Desktop

4. Downloads

%% Dropbox

Share View

£l Recent places
[5) ScanSnap Folder

B Desktop

*& Homegroup

J'lguﬂ:l

© - 1

. Favourites
B Desktop

4. Downloads

%# Dropbox

¥ Libraries » Documents » Arduino

-

CA\Users\Jimmy\Documei

~ MName Date modified Type Si:
. libraries 16 7:24 PM File folder
. Mew folder (62016 1:23 PM File folder
And it should look like this.
CA\Users\Jimm
Share View

L]

v Libraries » Documents | Arduino

Es

Mame " Date modified Type
. demo software 7652016 1:23 PM File folder
. libraries 31/9/2016 7:24 PM File folder

;
1= Recent places

(& ScanSnap Folder

B Desktop

1@ Homegroup



From the Downloads folder, right click and copy all the folder of the
“Wink_PreLoadedDemo” and paste it inside the demo software folder
which you have just created.

Wl U= Compressed Folder Tools Ch\Users\Jimmy\Downloads\
Haome Share View Extract
-:(__—) = 4 |4 » ThisPC » Downloads » Wink_PreLoadedDemo (1)zip
~ . ssed siz ssw i
s Favourites Mame Type Compressed size Password ...  Si
B Desktop . Wink_PreloadedDemo_Rey1 Eil foldar
4 Downloads =
%% Dropbox Explore
= Recent places Cut
[5G ScanSnap Folder I Copy
B Desktop Delete
0@ Homegroup Properties

Right click copy and paste inside here.

D= C:\Users\Jimm
Home Share View
Ii(__-:l - 1 ;¢ Libraries » Documents » #rduino
-~
. . ~ Mame Date modified Type
i Favourites 4
B Desktop , demo software 76/2016 1:23 PM File folder
& Downloads , libraries 375206 724 PM File folder

%# Dropbox

= Recent places
% ScanSnap Folder

B Desktop
#3, Homegroup

M This PC The “Wink_PreLoadedDemo” folder
4 Libraries should be inside the “demo software’
<] Documents folder like this.
| Documents
) Arduino

, demo software
; Wink_PreloadedDemo_Revil

20
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From your desk top, double click on the Arduino shortcut icon to re-launch the
Arduino IDE software.

Double click to
re-launch the

Arduino IDE
software

Once opened. It should look like this.

o) sketch_may31a | Arduino 1.6.9
File Edit Sketch Tools Help

sketch_may3ta

k:id setup() | ~
S/ put your setup code here, to run once:

vold loop() {

Arduine/Genuine Uno on COM1




Connecting your Robot

Ensure that you have all these items on hand. Wink robot, programming adapter and
(A USB) to (B mini) USB cable.

Connect the (B mini) USB cable to the programming adaptor.

22
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Now connect the ten pins supplied cable to the robot .

I IMPORTANT Ensure that the orientation of the ten pins cable is
correctly aligned and not twisted!

23
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Ensure all the ten pins is properly inserted into the connector of the robot.

Next, connect the USB cable to your computer.




You should see the LED lighted up on the robot and is on charging mode.

From the Arduino IDE, go to “Tools” > Board: select “Arduino Fio”

- : - - O %
o) sketch_jun07a | Arduino 1.6.9 - Boards Manager...
File Edit Sketch |Tools| Help R X L
Arduino AVR Boards
Auto Format Ctrl+T E . i
Archive Sketch ALnT
sketch_jun073 Fix Encoding & Reload M Arduino/Genuino Uno
void setup() Serial Monitor Ctrl+Shift+M ~ Arduino Duemilanove or Diecimila
f/ pat your Serial Plotter Cirl+ Shift+ L Arduine Nano
! Board: "Arduine Fio" 4 Arduine/Genuino Mega or Mega 2560
void loop() { Port ' Arduine Mega ADK
/¢ put your Get Board Info

Arduino Leonardo

1 Programmer: "AVRISP mkl" 4 Arduine/Genuine Micro
Burn Bootloader

Arduino Esplora
Arduino Mini
Arduino Ethernet

E Arduine Fio
Arduino BT
LityPad Arduino USE
LilyPad Arduino
Arduine Pro or Pro Mini
Arduino NG or older
Arduino Rebot Control
Arduine Robot Motor

Arduine Fio on GOM1 Arduino Gemma



From “Tools” again point to > Port: and you will see “COM 3”, “COM 4” depending
on your computer. If you don’t see any port available, try disconnecting the USB and
reconnect again. (This is a common problem, and it’s normal where the computer
needs to refresh to detect the port)

o) sketch_jun07a | Arduino 1.69 - o
File Edit Sketch |Tools Help

o o | Auto Format Ctrl+T E
Archive Sketch
sketeh_jun07a Fix Encoding & Reload :

void setup() Serial Monitor Ctrl+Shift+M "
{1/ put yeur Serial Plotter Ctri+Shift+L
1 Beoard: "Arduine Fio" 3
) o T ] ol ports
void loop{) { Port: "COM3’ Serial port:
/7 put your,  GetBoard Info COMS3
1 Programmer: "AVRISP mkll" 4

Burn Bootloader

Now, your Arduino IDE setup is ready to download sketches to the robot.
H Point to File > Sketchbook > demo software > Click “Wink_PreLoadedDemo”

0] sketch_jun07a | Arduino 1.6.9 - B
File | Edit Sketch Tools Help

New Ctrl+N E
Open... Ctrl+0
Open Recent L] :

Sketchbook L demao software ! Wink_PreLoadedDemo_RexQ]

Bempis N

Close Crl+W

Save Ctrl+S Cllck to open
Save As.. Ctrl+Shift+5

e, to run repeatedly:
Page Setup  Ctrl+Shift+P
Print Ctrl+P

Preferences  Ctrl+Comma

Quit Ctrl+Q

Arduino Fio on COM3
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A new Arduino IDE window will open with the entire “Wink_PreLoadedDemo”
sketch.

sketch_jun07a | Arduino 1.6.9 = =
File Wink_IRExample_Rev01_03 | Arduino 169 = o lEM

File Edit Sketch Tools Help

| sk
|-gi Wink_IRExample_Rev01_03

.-'"I A

Arduine Fio on COM4

Turn on your robot by pushing the Power Button as shown. The LED next to the
power button should be lighted up.




-

Click the arrow button to upload the sketch to your robot.

(o) Wink_PreLoadedDemo_Rev01 | Arduino 1.6.9 = =
File Edit Sketch Tools Help

Wink_P edDemo_Revil FunStuff.h FunStuff WinkHardware ™ v

| Click here =

Arduino Fio on COM3

While the program is compiling the sketch, you will see the green progress bar at the
bottom right of the Arduino IDE.

o) Wink_IRExample_Rev01_03 | Arduino 169 - ©
File Edit Sketch Tools Help

Wink_IRExample_Rev01_03 FunStufih Funstuff ‘WinkHardware.h 'I Wir

| A

Arduino Fio an COMS

28



The LED on the programming adaptor should be blinking while
compiling is in progress.

s, Once completed, you will hear a short beep on the robot and it
will show “Done uploading” at the bottom of the Arduino IDE.

H Congratulation! You have successfully uploaded the sketch on
your robot. Enjoy and Have Fun!

I Wink IRExample Rev01 03 | Arduino 169 — O
! File Edit Sketch Tools Help

Wink_IRExample_Rev01_03 FunStuff.h FunStuff WinkHardware.h 'I Wit

| A~

29



